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1 Altova Work in Process (WIP) XBRL add-in
for Excel, version 2018r2

The Altova Work in Process (WIP) XBRL add-in for Excel is targeted towards businesses and
organizations that submit Work in Process (WIP) financial data in XBRL format, as part of the
XBRL US Work in Process (WIP) reporting. 

The Altova Work in Process (WIP) XBRL add-in for Excel enables stakeholders in the WIP
process to do the following:

Enter XBRL US WIP data in Microsoft Excel, using a predefined template spreadsheet
which maps to the XBRL US WIP taxonomy. 
Validate the report data directly from Excel, to ensure it conforms to the XBRL US WIP
taxonomy.
Export the WIP report from Excel to XBRL format.
Import data from existing XBRL format WIP reports into Excel.

The currently supported taxonomy is the 2016 Surety Work in Process Taxonomy (see https://
xbrl.us/xbrl-taxonomy/2016-surety-wip/).

This documentation makes references to, and should be read in conjunction with, the "XBRL US
Work In Process Taxonomy 2016 Preparers Guide" (see http://taxonomies.xbrl.us/wip/2016/docs/
WipPreparersGuide.pdf).

https://xbrl.us/xbrl-taxonomy/2016-surety-wip/
https://xbrl.us/xbrl-taxonomy/2016-surety-wip/
http://taxonomies.xbrl.us/wip/2016/docs/WipPreparersGuide.pdf
http://taxonomies.xbrl.us/wip/2016/docs/WipPreparersGuide.pdf


6 Altova Work in Process (WIP) XBRL add-in for Excel, version 2018r2  

© 2018 Altova GmbHAltova Work in Process XBRL add-in for Excel, version 2018r2

System requirements
Windows 7 SP1 with Platform Update, Windows 8, Windows 10
Windows Server 2008 R2 SP1 with Platform Update or newer
Microsoft Excel 2016, 2013, 2010
.NET Framework 4.0 or later

The add-in is available for both Microsoft Excel 32-bit and 64-bit.

Last updated: 11 April 2018
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2 Installation and Licensing

To install the Altova Work in Process (WIP) XBRL add-in for Excel, download the executable from
the Altova website (https://www.altova.com) and run it. Follow the wizard steps to complete the
installation. You will need to accept the license agreement and privacy policy in order to proceed
with the installation.

Make sure to download the executable corresponding to your operating system's platform
(32-bit or 64-bit). The 32-bit executable can be installed on both 32-bit and 64-bit Windows;
however, it supports only Excel 32-bit.

After installation, a new tab called WIP becomes available in the Excel ribbon. 

Licensing
To use Altova Work in Process (WIP) XBRL add-in for Excel, a valid license key code is required.
To enter the license key code, or to purchase a new one, or to request a free evaluation from the
Altova website, take the following steps:

1. In the Excel ribbon, click the WIP tab.
2. Click Add-In Activation.

How to view the current version of the add-in
1. In the Excel ribbon, click the WIP tab.
2. Click About WIP Add-In.

https://www.altova.com
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3 Creating a new WIP Report

This topic shows you how to create a new (blank) WIP Report and also gets you familiar with the
graphical user interface of the WIP Add-In. Be aware that, as an alternative to creating a blank
WIP Report that is filled out manually, it is also possible to import data automatically from various
existing spreadsheets, see Importing Data.

To create a new WIP report:

1. In the Excel ribbon, click the WIP tab.
2. Click Insert.

3. Select the Blank WIP Report check box (this is the default option), and click OK.

Whenever you create a blank report, a new Excel sheet becomes available, called "WIP In
Process". 
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The "WIP In Process" sheet is bound to the XBRL taxonomy file, and enables you to enter data
directly in the supplied cells. 

If you need to produce the "WIP Complete" report in addition to the "WIP In Process" report, click
the WIP tab in the Excel ribbon, and select the Report Completed Contracts check box. This
adds a new sheet to the Excel workbook, called "WIP Complete". 

When clicked, each XBRL-bound cell inside the "WIP In Progress" or "WIP Complete" sheets
displays a description in the Cell Documentation box of the WIP Report pane. This description
originates in the underlying XBRL taxonomy.

Several XBRL report properties are available in the WIP Report pane to the right. These properties
directly affect the content of the XBRL instance file that will be created when you export the XBRL
instance. To view what each property does, click it and observe the description displayed in the
lower area of the WIP Report pane. For more information, refer to the "XBRL US Work In Process
Taxonomy 2016 Preparers Guide", primarily to Section 4, "DEI Taxonomy Logical Structure".

Because the "WIP In Process" and the "WIP Complete" sheets are bound to the XBRL taxonomy,
they must not be deleted. It is also not recommended to rename these sheets. If necessary, you
can add new sheets to the workbook; however, such sheets would not be bound to the XBRL
taxonomy, and consequently be ignored when you generate the XBRL instance file.
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4 Entering Data

You can use the standard Excel commands to paste cell values or entire rows into the "WIP In
Process" and "WIP Complete" sheets. You can also add new rows to the body of the report table,
or delete existing rows, in the standard Excel way.

Note that some cells include calculations and SUM formulas and they are filled automatically
when you fill in the corresponding source cells. These include sum cells, as well as columns such
as "Estimated Gross Profit" or "Estimated Contract Revenue". Columns that contain formulas
have the text header in italics and should not be edited, whereas editable cells have a gray
background.

When you paste cells or rows into the predefined sheets, be aware of the following:

The number of pasted columns should correspond to the number of columns in the
predefined sheet. If you accidentally paste a larger number of columns, or if you type text
outside the default table, unwanted columns may appear (named "Column 1", "Column2",
and so on).

To delete the unwanted columns, right-click the cell and select Delete > Table
Columns. To prevent Excel 2013 from adding new columns and rows automatically, go
to File > Options > Proofing > AutoCorrect Options > AutoFormat As You Type >
Apply as you work, and click to clear the Include new rows and columns in table
check box.

When pasting data, it is recommended to keep only the values (and not the formatting).
Namely, select the Paste Values option when pasting cells or rows:
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While generating the XBRL instance file, the add-in ignores any cell formatting information
and exports the actual value of the Excel cell. However, bear in mind that, as part of
Excel functionality, the actual value may be different from the value displayed in the cell,
because of the cell formatting information. You can view at any time the actual value (the
one that will be written to the XBRL instance) in the formula bar of Excel. Consider this
example:

In the example above, the value that will be written to the XBRL instance is 11987630.
Note that the number accuracy reported in the XBRL instance file will depend on the value
you selected for the "Accuracy" property (see Controlling Numeric Accuracy).

As you enter data in Excel, the add-in may round automatically values in those cells which
are calculated automatically (the so-called "calculated" cells, they always have a white
background). The add-in never rounds values in cells where you enter data (such cells appear
with a gray background).

However, when you export data to XBRL, both the manually entered cells and the calculated
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cells will be rounded automatically, if necessary, in the XBRL instance file. This behavior is
intentional; otherwise, it would lead to inconsistency warnings due to rounding. Note that
values in the original Excel spreadsheet remain unaffected after you export data to an XBRL
instance file.
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4.1 Reporting Miscellaneous Contracts

In a Work In Process report, contracts can have an identifier (see the "Contract Identifier"
column), or be reported as miscellaneous contracts. To report contracts as miscellaneous, do
one of the following:

Do not enter a value in the "Contract Identifier" column (leave the cell empty)
Enter either "n/a" or "misc" in the "Contract Identifier" column.

Any contracts where the conditions above are true will be reported as miscellaneous in the
generated XBRL instance. 

Note: Miscellaneous contracts should not contain any values in the "Contract Basic
Information" section of the Work In Process report (Excel columns "C" to "J"), except
"Contract Identifier" and "Contract Name". Any values present in these columns will raise
validation warnings and will not be exported when you click the Export button.
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4.2 Controlling Numeric Accuracy

The accuracy of monetary and other numeric values in the XBRL WIP report can be controlled by
setting the following report properties:

1. Accuracy of Monetary Items
2. Accuracy of Percentage Items

These properties are available in the WIP Report pane.

Most of report items are numeric monetary items, so the property Accuracy of monetary items
applies to nearly all numeric cells in the report. The property Accuracy of Percentage items
applies to values that represent a percentage (such as values in the "Percent Complete" column).

In the XBRL instance file, the "Accuracy" properties are bound to the decimals attribute. By
default, they are set as follows:

The Accuracy of Monetary Items is set to Units, which sets the value of the decimals
attribute in the XBRL instance to "0".
The Accuracy of Percentage Items is set to Cents, which sets the value of the
decimals attribute in the XBRL instance to "2". 

To find out how each "Accuracy" property value affects the decimals attribute in the XBRL
instance file, see the third column of the table below. You can either set the accuracy to one of
the predefined values or specify a custom accuracy value. The predefined values are listed in the
table below.

Accuracy
value

Meaning Sets the value of the
"decimals" attribute
in the XBRL instance
to...

Exact This is the default value. When this value is selected,
the accuracy will be maintained exactly as you
entered it.

INF
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Accuracy
value

Meaning Sets the value of the
"decimals" attribute
in the XBRL instance
to...

Billions Maintains accuracy up to 9 digits to the left of the
decimal point (billions). 

-9

Millions Maintains accuracy up to 6 digits to the left of the
decimal point (millions).

-6

Thousands Maintains accuracy up to 3 digits to the left of the
decimal point (thousands).

-3

Units Maintains accuracy up to integers. 0

Cents Maintains accuracy up to 2 digits to the right of the
decimal point.

2

Mills Maintains accuracy up to 3 digits to the right of the
decimal point.

3

Note: Do not set the Accuracy of Percentage Items property to "Units", "Billions", "Millions",
or "Thousands". Instead, use the "Exact", "Cents" or "Mills" accuracy values, or a
custom value that would not result in an incorrectly rounded value in the XBRL instance. 
For example, a percent value of "23%" in the Excel report, using an accuracy of Cents,
would be reported as "0.23" in the XBRL instance and rounded to 2 decimals to the right
of the decimal point (which is acceptable). Using an accuracy of Units is not acceptable,
since it would round 0.23 to 0.

As shown in the table, the accuracy value can be either positive or negative. 

A positive value N specifies the accuracy of up to N digits to the right of the decimal place. For
example, the value 2 specifies the accuracy to be in cents, while the value 3 specifies the
accuracy to be up to mills. 

A negative value N specifies the accuracy of up to N digits to the left of the decimal place. For
example, the value -3 specifies the accuracy to be up to thousands, while the value -6 specifies
the accuracy to be up to millions.

As you enter data in Excel, the add-in may round automatically values in those cells which
are calculated automatically (the so-called "calculated" cells, they always have a white
background). The add-in never rounds values in cells where you enter data (such cells appear
with a gray background).

However, when you export data to XBRL, both the manually entered cells and the calculated
cells will be rounded automatically, if necessary, in the XBRL instance file. This behavior is
intentional; otherwise, it would lead to inconsistency warnings due to rounding. Note that
values in the original Excel spreadsheet remain unaffected after you export data to an XBRL
instance file.
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4.3 Resetting Data and Restoring Formulas

In some cases, you might want to clear all entered data from the WIP report sheet in one
operation. For example, you might want to do that when you discover that validation fails after you
have pasted some data from an external source. 

The Reset WIP Report Data command is available in the WIP tab and it performs the following
actions:

Clears all data from the sheet
Restores the Excel formulas to their default state
Restores the WIP report properties to their default state.

Note: The Reset WIP Report Data command does not affect the cell formatting.

To reset the WIP report data, click Reset WIP Report Data > Reset WIP Report data in the
Excel ribbon. A confirmation dialog box prompts you for confirmation before data is actually
cleared.

Restoring only formulas
You can also restore the Excel formulas to their default state, without clearing the existing data.
This is necessary, for example, after you imported data from an XBRL report instance. To restore
only formulas, click Reset WIP Report Data > Restore only formulas in the Excel ribbon.
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4.4 Adding XBRL Footnotes

If you add comments to any of the XBRL-bound cells, the comments are automatically translated
into XBRL footnotes in the exported XBRL instance.

For example, the comment above would look as follows in the exported XBRL instance:
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5 Importing Data

As an alternative to entering data manually into the "WIP In Process" or "WIP Completed" sheets,
you can also import it from custom Excel sheets or workbooks, including NASBP (National
Association of Surety Bond Producers) Excel sheets. You can also import data from existing
XBRL WIP reports saved with the Altova Work in Process (WIP) XBRL add-in for Excel. 

The various import options listed below are all available in the Altova Work in Process (WIP) XBRL
add-in for Excel. These options enable you to keep the source data for the WIP reports in a layout
that is perhaps more convenient to your organization, and quickly import it into the "WIP In
Process" or "WIP Completed" sheets as and when necessary. 

Importing Data Using Data Mappings Use this option to import data from custom Excel
workbooks. This option requires that a data mapping be
created first. A "data mapping" means that specific
fields in the WIP report will map to specific cell ranges
in your custom sheet. It is you who decides what
should map to what. The source data can be either in a
different sheet in the same workbook, or in an external
workbook.

Once the data mapping is ready, you can automatically
populate the WIP data sheets from your custom sheet.
This is done with a click of a button (either the Copy
Values or Reference Values button).

Data mappings are saved together with the WIP
workbook. This makes them suitable for on demand or
recurring imports into the same workbook. To become
reusable across multiple workbooks, data mappings
must be saved as templates (see next option).

Importing Data Using Templates Use this option to import data from custom Excel
workbooks for which you already have prepared a
template. A template is just a permanently saved data
mapping between specific fields in the WIP report and
specific cell ranges in any custom sheet. 

This requires that all your source workbooks have the
same layout that is recognized by the template. Unlike
data mappings, templates are saved to a special
template folder that you designate, and thus are
reusable across multiple workbooks. You can define as
many templates as required, one for each custom
Excel sheet from where you need to import data.

Importing Data From NASBP Excel
Sheets

Use this option to import data from sheets produced by
the NASBP (National Association of Surety Bond
Producers). As long as the source sheet is a valid
NASBP sheet, the add-in will automatically import data
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from it; no other setup is required.

Importing Data From Existing XBRL
WIP Reports

Use this option to import existing WIP Report data that
was saved in XBRL format with the Altova Work in
Process (WIP) XBRL add-in for Excel.
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5.1 Importing Data Using Data Mappings

Data mappings are a flexible way to import data from an external workbook, or from a different
sheet of the same workbook, into a WIP Report. Data mappings are saved references between
the WIP report fields and any cell ranges in a custom sheet. The data mappings are saved
together with the WIP workbook they are part of and they are typically most appropriate for on
demand or recurring imports of data into the same workbook.

Data mappings can become reusable across multiple workbooks if you save them as templates,
see Importing Data Using Templates.

To set up a data mapping:

1. Open the workbook which contains an existing WIP Report, or create a new WIP Report
(see Creating a new WIP Report).

2. Click the Data Mapping tab in the WIP Report Pane.

3. If you want to import values in the "WIP In Process" sheet, click the In Process tab. To
import values in the "WIP Completed" sheet, click the Completed tab.

4. Enter a source cell range next to the field where data must be imported. You can either
type the cell range manually, or click the  button and select the required cell range
from a source sheet. In the example below, the field Contract Name is mapped to the
source cell range $B$4:$B$8 originating from a sheet named "Sheet1".

You can also map cell ranges from Excel files other than the current workbook. The same
instructions as above apply, the only requirement is that both the source and target Excel
books are currently open. In the example below, the field Contract Name is mapped to
the source cell range $B$4:$B$8 originating from a sheet named "Sheet1" of a separate
Excel book called "Book1".
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Note: The source cell range must consist of either a single row or a single column. Values can
be copied or referenced from other workbooks or sheets as long as they represent valid
Excel cell ranges. It does not matter if the range is vertical or horizontal in the source
sheet; in the "WIP In Process" and "WIP Completed" sheets, the imported cell ranges
will automatically conform to the required layout. For examples of creating references to
cell ranges, see https://support.office.com/en-US/article/Create-or-change-a-cell-
reference-C7B8B95D-C594-4488-947E-C835903CEBAA.

5. Repeat the previous step for each WIP report field that must be mapped to a source cell
range.

Once you set up the data mapping, you can copy or reference the actual values.

There are two ways to import values from a source sheet: copying or referencing them. Copying
means that the value is literally taken from the source range and placed into the target; also, if the
source value changes, then it is not automatically updated in the target WIP sheets (you can
however update the WIP report from the source at any time by clicking a Copy Values button).
Referencing means that, instead of storing an actual value, the WIP sheet will contain a formula
which refers to the source cell range; updating the value in the source will also automatically
update it in the target sheet next time when you open the target sheet.

To copy or reference the mapped cell ranges:

1. Click the Data Mapping tab in the WIP Report Pane.

2. Click either Copy Values or Reference Values (see the explanation above for the
difference between these two options).

3. When prompted that you are about to overwrite data in the WIP report, click OK to
confirm.

Note the following:

When you click the Copy Values or Reference Values button, values are copied (or
referenced) from all data mapping tabs (In Progress and Completed), not just the

https://support.office.com/en-US/article/Create-or-change-a-cell-reference-C7B8B95D-C594-4488-947E-C835903CEBAA
https://support.office.com/en-US/article/Create-or-change-a-cell-reference-C7B8B95D-C594-4488-947E-C835903CEBAA
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current visible tab.
If you copy or reference values from another Excel book, both books must be open for
values to be copied or referenced correctly.
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5.2 Importing Data Using Templates

Templates represent reusable data mappings between fields in the WIP report and cell ranges in a
custom sheet. The source cell ranges may be horizontal (for example, A1:Z1) or vertical (for
example, A1:A30). Templates are very similar to the data mappings described in Importing Data
Using Data Mappings. However, unlike data mappings, templates are reusable across multiple
workbooks, because they are saved as independent files (not inside the workbook, like data
mappings). With templates, it is therefore possible to import data from virtually any source
workbook that contains the cell ranges predefined by the template. 

A significant difference between data mappings and templates is that the cell ranges referenced
by a data mapping are fixed (predetermined) while cell ranges referenced by templates can grow if
more rows or columns of data are available in the source (likewise, they can shrink if less rows or
columns are available in the source). Also, unlike data mappings, all mapped cell ranges in a
template must originate from the same workbook, and from the same worksheet, as further
explained below. 

Creating a template
You can create a new template as follows:

1. Open any existing Excel workbook which contains WIP data in custom (not XBRL-bound)
format.

2. On the WIP tab, click Insert, and add a blank WIP report into the workbook (see also
Creating a new WIP Report).
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3. In the WIP Report Pane, click the Data Mapping tab. Notice this tab has three other
tabs: In Process, Completed, and DEI (Document Entity Information). The first two tabs
let you map fields belonging to the "In Process" and "Completed" sheets, respectively.
The DEI tab lets you map data for those fields which appear in the Document properties
(such as the start and end date of the reporting period, Registrant Name, and others).
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4. Enter a cell range next to each field in the WIP report that you want to be part of the
template. You can either type the cell range, or click the Ellipsis  button and then
select the range from the source sheet (in the latter case, the range will be populated
automatically). For example, the image below illustrates the field "Contract Identifier"
mapped to the cell range B3:B7 of Sheet1. The cell range selection mechanism is the
same that you use for Excel formulas, see https://support.office.com/en-US/article/
Create-or-change-a-cell-reference-C7B8B95D-C594-4488-947E-C835903CEBAA.

https://support.office.com/en-US/article/Create-or-change-a-cell-reference-C7B8B95D-C594-4488-947E-C835903CEBAA
https://support.office.com/en-US/article/Create-or-change-a-cell-reference-C7B8B95D-C594-4488-947E-C835903CEBAA
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Rules for referencing cell ranges

All cell ranges must consist of either single rows (for example A1:K1) or
single columns (for example, A1:A20). In other words, all of them must be
either vertical or horizontal.
All cell ranges must originate from the same worksheet of the same
workbook.
All cell ranges must begin and end on the same row (or column in case of
vertical ranges). For example, an error would be raised if the field "Contract
Identifier" used the range B1:B10 and the field Contract Name used the
range C2:C9. However, no error would be raised if these fields used the
range B1:B20 and C1:C20, respectively. 

When you apply the template to a workbook, it may be the case that more or less
rows or columns are available in the source workbook than specified by the template
cell range—in this case, the cell range will grow or shrink to match the exact number
of rows or columns.

5. Once you've mapped all required fields to cell ranges, click Save Template. At this
stage, some validation takes place, and error messages may appear with indicative text
(to fix the errors, see the rules above). Otherwise, the dialog box below is displayed.
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6. Optionally, select a destination template folder. By default, the template folder is C:
\Users\...\Documents\Altova\WIPAddInForExcel. You can optionally change this folder

to another one, by clicking the Ellipsis  button.
7. Enter a file name in the File name box. The template will be saved to the selected

template folder as a file with .wdmt (WIP Data Mapping Template) extension.
8. Optionally, enter in the Template name box some descriptive text to help you identify

this template later (for example, "Template 1").
9. Click Save.

If your WIP worksheet already contains previously defined data mappings (as explained in 
Importing Data Using Data Mappings), it is possible to save them as a template (meaning that
you can skip directly to step 5 above). Note the following:

All data mappings must adhere to the "Rules for referencing cell ranges" listed above;
otherwise, relevant errors will be shown, and the template will not be saved.
Templates are meant to be reusable and not bound to specific workbooks, like data
mappings. Therefore, when you save data mappings as a template, any references to
specific workbooks (if such exist) are removed. Only references to worksheets and cell
ranges will be preserved by the template. For example, a cell range such as 
[CustomBook.xlsx]CustomSheet!$C$4:$C$8 would be saved only as

CustomSheet!$C$4:$C$8.

Editing existing templates
Templates saved previously can be modified if necessary, as follows:

1. Open any workbook that contains an XBRL-bound WIP Report sheet.
2. Click the Data Mapping tab in the WIP Report pane.



© 2018 Altova GmbH

Importing Data Using Templates 29Importing Data

Altova Work in Process XBRL add-in for Excel, version 2018r2

3. Click Load Template.

4. Select the required template from the list of available templates, and then click Load. If

the templates were saved to a custom template folder, click the Ellipsis  button to
switch the template folder.

5. Edit the cell ranges In the Data Mapping tab as necessary. The same rules apply as
when adding new templates, see Rules for referencing cell ranges.

6. Click Save template.

How to apply a template to a custom Work-In-Process workbook
Once you have created a template, it can be applied to virtually any source workbook that
contains the cell ranges defined by the template.

1. Open any custom Excel workbook that contains the cell ranges defined by the template.
2. In the WIP tab of the Excel ribbon, click Insert. Notice that the right-hand area of the

dialog box below displays any open Excel workbooks and their worksheets (in this
example, the workbook CustomBook.xlsx and the sheet "CustomSheet"). 
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3. Under Custom, select the template name (in this example, "Template1"). Any template
files available in the Template Folder appear on this dialog box automatically. If no
template files appear on the dialog box, make sure that the template folder contains
.wdmt template files that you've created previously (see "How to create a template"

above). To switch the template folder, click the Ellipsis  button.
4. Click either the In Process or Completed tab, depending on the kind of WIP report you

wish to import data into.
5. Click Open Workbook and browse for the Excel book from where you would like to

import data (you can ignore this step if the source Excel workbook is already open). In
this example, the source workbook was already opened in step 1 so this step can be
ignored.

6. Select the worksheet from which you would like to import data (in this example, data is
being imported from worksheet "CustomSheet" of workbook CustomBook.xlsx).
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7. Under Mapping Method, select either Copy or Reference (see explanation below), and
click OK.

There are two ways to import values from a source sheet: copying or referencing them. Copying
means that the value is literally taken from the source range and placed into the target; also, if the
source value changes, then it is not automatically updated in the target WIP sheets (you can
however update the WIP report from the source at any time by clicking a Copy Values button).
Referencing means that, instead of storing an actual value, the WIP sheet will contain a formula
which refers to the source cell range; updating the value in the source will also automatically
update it in the target sheet next time when you open the target sheet.
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5.3 Importing Data From NASBP Excel Sheets

If your organization works with Work In Process Excel sheets created by the NASBP (National
Association of Surety Bond Producers), it is possible to import data from such sheets
automatically into the XBRL-bound reports (either the WIP In Process or the WIP Completed
report). There are two ways to do this:

1. Import existing NASBP Excel data into a new XBRL-bound Excel sheet. 
2. Create new XBRL-bound sheets directly in the existing NASBP Excel workbook.

There are two ways to import values from a source sheet: copying or referencing them. Copying
means that the value is literally taken from the source range and placed into the target; also, if the
source value changes, then it is not automatically updated in the target WIP sheets (you can
however update the WIP report from the source at any time by clicking a Copy Values button).
Referencing means that, instead of storing an actual value, the WIP sheet will contain a formula
which refers to the source cell range; updating the value in the source will also automatically
update it in the target sheet next time when you open the target sheet.

To import NASBP data into a new XBRL-bound sheet:

1. Create a new blank Excel workbook.
2. In the Excel ribbon, click the WIP tab, and then click Insert. 
3. Select the NASBP WIP Report check box. 

4. Click Open Workbook and browse for the NASBP Excel book from which you want to
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import data. The dialog box below opens. Notice that the right-hand side of the dialog box
displays all sheets from all currently open Excel workbooks (except for hidden sheets,
and the XBRL-bound WIP In Process or WIP Completed sheets). Any sheets that are
detected to be valid NASBP sheets are enabled and can be selected as source; the
others are grayed out. In the image below, the current book is "Book1". Since "Sheet1"
does not contain NASBP data, it is grayed out.

5. Select the check box next to the sheet from where you want to import data. In the image
below, the name of the source workbook is NASBP.xlsx, and it contains a sheet "WIP"
which qualifies for automatic import.
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6. To import data into the "WIP In process" sheet, click the In Process tab. Likewise, to
import NASBP data into the "WIP Completed" sheet, click the Completed tab.

7. Under Mapping Method, choose an import option (Copy or Reference, as explained at
the top of this page), and click OK.

To create an XBRL-bound Work in Process sheet directly in the NASBP Excel workbook:

1. Open the existing NASBP Excel workbook.
2. In the Excel ribbon, click WIP, and then click Insert.
3. Select the NASBP WIP Report check box. The dialog box below displays sheets from

all currently open workbooks (in this case, NASBP.xlsx). Sheets which are detected to
be valid for NASBP import are enabled; other sheets, if available, are grayed out.
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4. To import data into the "WIP In process" sheet, click the In Process tab. Likewise, to
import NASBP data into the "WIP Completed" sheet, click the Completed tab.

5. Select the check box next to the sheet from where you want to import data (in the image
above, "WIP").



36 Importing Data Importing Data From NASBP Excel Sheets

© 2018 Altova GmbHAltova Work in Process XBRL add-in for Excel, version 2018r2

6. Under Mapping Method, choose an import option (Copy or Reference, as explained at
the top of this page), and click OK.
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5.4 Importing Data From Existing XBRL WIP Reports

You can import data from existing instances of XBRL WIP reports into Excel (typically, files with
either .xbrl or .xml extension). For the import to be successful, the imported instances must be
valid XBRL WIP reports. They may be either reports you have previously generated using the
Altova Work in Process (WIP) XBRL add-in for Excel, or reports that you received from other
parties. 

When you import data from an XBRL instance file, the Excel sum formulas are overridden by
the imported values. After the import, you will need to restore the Excel formulas to the
default state. To do this, click Reset WIP Report Data > Restore only formulas in the
Excel ribbon (see Resetting Data and Restoring Formulas).

To import an XBRL US WIP report instance file into Excel:

1. In the Excel ribbon, click the WIP tab.
2. Click Insert.
3. Click Import XBRL, and browse for the XBRL instance file. 

Before the report data is loaded into Excel, it is automatically validated. A dialog box notifies you
about potential warnings, inconsistencies, or errors (see also Validating Data). 

Note: During import, the add-in validates XBRL formula assertions. A report will be imported
even if it contains unsatisfied assertions.
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6 Validating Data

Validation ensures that the XBRL data you are filing conforms to the XBRL specification. The WIP
report data should be validated before you export it to XBRL. You might also want to validate data
progressively, after each action that could potentially render it invalid (for example, after pasting
new rows into the spreadsheet).

To validate data, click the Validate button in the WIP tab of the Excel ribbon.

Be patient while Altova Work in Process (WIP) XBRL add-in for Excel performs the validation
process (typically, a few seconds). When validation completes, a dialog box appears, containing
a validation report. 

The validation result can be any of the following:

Message
type

Meaning

The instance data is valid.

The instance data is valid, but has inconsistencies or warnings.

The instance data is not valid. 

The Validation Report dialog box may additionally display any of the following message types:
information messages, warnings, and errors. 
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Message
type

Meaning

Denotes an information message. Information messages do not make the XBRL
instance invalid.

Denotes a warning message, or an inconsistency. Warnings and
inconsistencies do not make the XBRL instance invalid. 

In some cases, you may choose to ignore inconsistency messages, depending
on the situation. As stated in the XBRL US Work In Process Taxonomy 2016
Preparers Guide, some validation messages may be ignored under certain
circumstances (see the section "Calculation").

Denotes an error. If there are validation errors, the XBRL instance is not valid,
and you will need to edit the report data so as to resolve each error before
proceeding with the export to XBRL.

Note: During validation, the add-in checks XBRL formula assertions and reports
them as errors. If you are using the Altova RaptorXML+XBRL Server for validation
(https://www.altova.com/raptorxml), XBRL formula assertions may be optionally
configured not to be reported as errors. 

To copy the contents of the validation report to clipboard, click Copy, and then paste into a target
file (for example, an email).

https://www.altova.com/raptorxml
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7 Exporting Data to XBRL

Once your WIP report is ready and valid (see Validating Data), you can generate the XBRL
instance file. To do this, click the Export XBRL button in the WIP Report pane. Alternatively,
click the WIP tab, and then click Export XBRL.

Note: If you need to export both the "WIP In Process" and the "WIP Completed" reports, select
the Report Completed Contracts check box in the Excel ribbon.

By default, instance files are saved as files with .xbrl extension. If you need the exported file to
have another extension (for example, .xml), type the file extension in the Export dialog box:

Before export, data is automatically validated. Any errors, inconsistencies and warnings are
reported on the screen. 

The XBRL instance file is created even if data is not valid; however, such report instances are not
valid for XBRL submission (see also Validating Data).
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In case of invalid reports, the cell values that are XBRL incompatible are ignored and not written to
the XBRL instance file. For tips on how to avoid data formatting errors, see Entering Data. Note,
however, that not all XBRL validation errors might be related to incorrect formatting. Some errors
might occur because your data does not meet the XBRL validation rules set out in the "XBRL US
Work In Process Taxonomy 2016 Preparers Guide".

To copy the contents of the validation report to clipboard, click Copy, and then paste into a target
file (for example, an email).
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8 Command Reference

The add-in commands available the WIP tab of the Excel ribbon are listed below.

Insert Creates a new WIP report. This command is disabled if the WIP report
sheet has already been inserted into the workbook.

Toggle Actions
Pane

Shows or hides the "WIP Report" pane. By default, the "WIP Report"
pane is visible.

Reset WIP Report
Data

This is a split button which contains the following commands:

Reset WIP Report Data

Discards (deletes) any data entered in the "WIP In Process" or
"WIP Completed" sheets, and returns the Excel formulas to their
default state. A confirmation dialog box prompts you for
confirmation before data is actually discarded.

Restore only formulas

Restores the Excel formulas to their default state, without
deleting any data.

See also Resetting Data and Restoring Formulas.

Report
Completed
Contracts

When selected, this option adds the "WIP Completed" sheet to the
current workbook. This may be necessary if you want to report the
completed WIP, in addition to the "WIP In Progress" data.

Validate Performs a validation of the WIP data against the underlying XBRL US
WIP taxonomy and displays the validation results in a dialog box (see 
Validating Data).

Import XBRL Imports an XBRL WIP instance file to the current Excel spreadsheet (see 
Importing WIP Data from XBRL).

Import Template Imports data from custom WIP workbooks by means of predefined
templates (see Importing Data Using Templates).

Export XBRL Exports the WIP data from the "WIP In Process" sheet (and, if applicable,
from the "WIP Complete" sheet to an XBRL instance file (see Exporting
WIP Data to XBRL).
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Help Opens this help file, in CHM (Microsoft Compiled HTML Help) format.

Add-In Activation Displays the activation status of the add-in, or provides options to enter or
purchase a license key code.

About Displays version information about the add-in.

Altova on the
Web

Provides links to the Altova website (including Online Support Center,
components download page, training and tutorials).
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9 License Information

This section contains:
 

Information about the distribution of this software product 
Information about software activation and license metering 
Information about the intellectual property rights related to this software product 
The Software License Agreement governing the use of this software product

Please read this information carefully. It is binding upon you since you agreed to these terms
when you installed this software product.
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9.1 Electronic Software Distribution

This product is available through electronic software distribution, a distribution method that
provides the following unique benefits:

 

You can evaluate the software free-of-charge before making a purchasing decision.
Once you decide to buy the software, you can place your order online at the Altova
website and immediately get a fully licensed product within minutes.
When you place an online order, you always get the latest version of our software.
The product package includes a comprehensive integrated onscreen help system. The
latest version of the user manual is available at www.altova.com (i) in HTML format for
online browsing, and (ii) in PDF format for download (and to print if you prefer to have the
documentation on paper).

30-day evaluation period
After downloading this product, you can evaluate it for a period of up to 30 days free of charge.
About 20 days into this evaluation period, the software will start to remind you that it has not yet
been licensed. The reminder message will be displayed once each time you start the application.
If you would like to continue using the program after the 30-day evaluation period, you have to
purchase anAltova XBRL Add-in Software License Agreement, which is delivered in the form of a
key-code that you enter into the Software Activation dialog to unlock the product. You can
purchase your license at the online shop at the Altova website. 

Helping Others within Your Organization to Evaluate the Software
If you wish to distribute the evaluation version within your company network, or if you plan to use it
on a PC that is not connected to the Internet, you may only distribute the Setup programs,
provided that they are not modified in any way. Any person that accesses the software installer
that you have provided, must request their own 30-day evaluation license key code and after
expiration of their evaluation period, must also purchase a license in order to be able to continue
using the product.

For further details, please refer to the Altova XBRL Add-in Software License Agreement at the end
of this section.

https://www.altova.com/
https://www.altova.com/
https://www.altova.com/documentation.html
https://www.altova.com/
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9.2 Software Activation and License Metering

As part of Altova’s Software Activation, the software may use your internal network and Internet
connection for the purpose of transmitting license-related data at the time of installation,
registration, use, or update to an Altova-operated license server and validating the authenticity of
the license-related data in order to protect Altova against unlicensed or illegal use of the software
and to improve customer service. Activation is based on the exchange of license related data
such as operating system, IP address, date/time, software version, and computer name, along
with other information between your computer and an Altova license server.

Your Altova product has a built-in license metering module that further helps you avoid any
unintentional violation of the End User License Agreement. Your product is licensed either as a
single-user or multi-user installation, and the license-metering module makes sure that no more
than the licensed number of users use the application concurrently.

This license-metering technology uses your local area network (LAN) to communicate between
instances of the application running on different computers. 

Single license 
When the application starts up, as part of the license metering process, the software sends a
short broadcast datagram to find any other instance of the product running on another computer in
the same network segment. If it doesn't get any response, it will open a port for listening to other
instances of the application.

Multi license
If more than one instance of the application is used within the same LAN, these instances will
briefly communicate with each other on startup. These instances exchange key-codes in order to
help you to better determine that the number of concurrent licenses purchased is not accidentally
violated. This is the same kind of license metering technology that is common in the Unix world
and with a number of database development tools. It allows Altova customers to purchase
reasonably-priced concurrent-use multi-user licenses.

We have also designed the applications so that they send few and small network packets so as
to not put a burden on your network. The TCP/IP ports (2799) used by your Altova product are
officially registered with the IANA (see the IANA website (http://www.iana.org/) for details) and our
license-metering module is tested and proven technology.

If you are using a firewall, you may notice communications on port 2799 between the computers
that are running Altova products. You are, of course, free to block such traffic between different
groups in your organization, as long as you can ensure by other means, that your license
agreement is not violated.

You will also notice that, if you are online, your Altova product contains many useful functions;
these are unrelated to the license-metering technology.

http://www.iana.org/assignments/service-names-port-numbers/service-names-port-numbers.xml
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9.3 Intellectual Property Rights

The Altova Software and any copies that you are authorized by Altova to make are the intellectual
property of and are owned by Altova and its suppliers. The structure, organization and code of the
Software are the valuable trade secrets and confidential information of Altova and its suppliers.
The Software is protected by copyright, including without limitation by United States Copyright
Law, international treaty provisions and applicable laws in the country in which it is being used.
Altova retains the ownership of all patents, copyrights, trade secrets, trademarks and other
intellectual property rights pertaining to the Software, and that Altova’s ownership rights extend to
any images, photographs, animations, videos, audio, music, text and "applets" incorporated into
the Software and all accompanying printed materials. Notifications of claimed copyright
infringement should be sent to Altova’s copyright agent as further provided on the Altova Web
Site.

Altova software contains certain Third Party Software that is also protected by intellectual property
laws, including without limitation applicable copyright laws as described in detail at http://
www.altova.com/legal_3rdparty.html.

All other names or trademarks are the property of their respective owners.

http://www.altova.com/legal_3rdparty.html
http://www.altova.com/legal_3rdparty.html
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9.4 Altova XBRL Add-in Software License Agreement

The license agreement below applies to the following Altova XBRL Add-in software products:

Altova WIP XBRL Add-in Software
Altova EBA XBRL Add-in Software  

THIS IS A LEGAL DOCUMENT -- RETAIN FOR YOUR RECORDS

ALTOVA® XBRL ADD-IN SOFTWARE LICENSE AGREEMENT

Licensor:
Altova GmbH
Rudolfsplatz 13a/9
A-1010 Wien
Austria

Important - Read Carefully. Notice to User:

This Software  License  Agreement (“Agreement”) is a  legal  document between you  and
Altova  GmbH (“Altova”).  It  is important  that  you  read  this  document  before  using  the
Altova-provided software (“Software”) and any accompanying documentation,  including,
without  limitation  printed  materials,  ‘online’  files,  or  electronic  documentation
(“Documentation”).  By  clicking  the  “I  accept”  and  “Next”  buttons  below,  or  by
downloading, installing, or otherwise  using the  Software,  you agree  to be  bound by the
terms of this Agreement as well as the Altova Privacy Policy (“Privacy Policy”) including,
without  limitation,  the  warranty  disclaimers,  limitation  of  liability,  data  use  and
termination provisions below, whether or not you decide  to purchase  the  Software.  You
agree  that  this  Agreement  is  enforceable  like  any  written  agreement  negotiated  and
signed by you.  If  you  do  not  agree,  you  are  not  licensed  to  use  the  Software,  and  you  must
destroy  any downloaded copies  of the Software in your  possession  or  control.  You  may  print  a
copy of this Agreement as part of the installation process at the time of acceptance.  Alternatively,
a  copy  of  this  Agreement  may  be  found  at  http://www.altova.com/legal.html  and  a  copy  of  the
Privacy Policy may be found at http://www.altova.com/privacy.

1.  SOFTWARE LICENSE

A. License  Grant.   Upon  your  acceptance  of  this  Agreement  Altova  grants  you  a  non-
exclusive,  non-transferable (except  as  provided below),  limited license,  without  the  right  to  grant
sublicenses,  to install  and use a copy of the Software on  one  compatible  personal  computer  or
workstation. The term of the license is delineated in your purchasing documents. The license may
not  be installed on more than one personal computer or workstation at  any  given  time  and  may
not be installed on more than two personal computers or workstations over a thirty-day period. 

B. Backup and Archival Copies.  You may make one (1) backup and one (1) archival copy
of  the  Software,  provided  your  backup  and  archival  copies  are  not  installed  or  used  on  any
computer  and  further  provided  that  all  such  copies  shall  bear  the  original  and  unmodified
copyright, patent  and other intellectual property  markings that  appear on or in the Software.  You
may  not  transfer  the  rights  to  a  backup  or  archival  copy  unless  you  transfer  all  rights  in  the

http://www.altova.com/legal.html
http://www.altova.com/privacy
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Software as provided under Section 3.

C. Key  Codes,  Upgrades  and  Updates.   Prior  to  your  purchase  and  as  part  of  the
registration for the thirty  (30) day evaluation period,  as  applicable,  you  will  receive  an  evaluation
key code.  You will  receive a purchase key code when you  elect  to  purchase  the  Software  from
either Altova GmbH or an authorized reseller.  The purchase key code will  enable you to activate
the Software beyond the initial evaluation period.  You may not  re-license,  reproduce or distribute
any key code except with the express written permission of Altova.  If the Software that  you have
licensed is  an upgrade or an update,  then  the  latest  update  or  upgrade  that  you  download  and
install  replaces  all  or  part  of  the  Software  previously  licensed.  The  update  or  upgrade  and  the
associated license keys does not  constitute the granting of a second license to the  Software  in
that you may not use the upgrade or updated copy in addition to the copy of the Software that it is
replacing and whose license has terminated.

D. Title.   Title  to  the  Software  is  not  transferred  to  you.  Ownership  of  all  copies  of  the
Software and of copies  made by you is  vested in Altova,  subject  to the  rights  of  use  granted  to
you in this Agreement. 

E. Reverse  Engineering.   Except  and  to  the  limited  extent  as  may  be  otherwise
specifically  provided  by  applicable  law in  the  European  Union,  you  may  not  reverse  engineer,
decompile,  disassemble  or  otherwise  attempt  to  discover  the  source  code,  underlying  ideas,
underlying  user  interface  techniques  or  algorithms  of  the  Software  by  any  means  whatsoever,
directly or indirectly, or disclose any of the foregoing,  except  to the extent  you may be expressly
permitted to decompile under applicable law in the European Union,  if it  is  essential to  do  so  in
order  to  achieve  operability  of  the  Software  with  another  software  program,  and  you  have  first
requested Altova to provide the information necessary  to achieve such operability  and Altova has
not made such information available. Altova has the right  to impose reasonable conditions and to
request a reasonable fee before providing such information.  Any information supplied by  Altova or
obtained by  you,  as  permitted  hereunder,  may  only  be  used  by  you  for  the  purpose  described
herein  and  may  not  be  disclosed  to  any  third  party  or  used  to  create  any  software  which  is
substantially similar to the expression of the Software.  Requests  for information from users  in the
European  Union  with  respect  to  the  above  should  be  directed  to  the  Altova  Customer  Support
Department. 

F. Other Restrictions. 

You may not  rent,  lease,  lend,  redistribute,  sublicense,  or transfer all  or  a  portion  the  Software,
except  to the limited extent  set  forth in Section 3 or as  otherwise  expressly  provided.  You  may
not  permit  any  use  of  or  access  to  the  Software  by  any  third  party  in  connection  with  a
commercial service offering, such as for a cloud-based or web-based SaaS offering.

You may not copy the Software except as expressly set forth above, and any copies  that  you are
permitted to make pursuant to this Agreement must contain the same copyright,  patent  and other
intellectual property  markings that  appear on or  in  the  Software.  You  may  not  modify,  adapt  or
translate the Software. You may not, directly  or indirectly,  encumber or suffer to exist  any lien or
security interest on the Software; knowingly take any action that  would cause the Software to be
placed in the public domain; or use the Software in any computer environment not specified in this
Agreement.

You will  comply  with applicable law and Altova’s  instructions regarding  the  use  of  the  Software.
You  agree  to  notify  your  employees  and  agents  who  may  have  access  to  the  Software  of  the
restrictions contained in this Agreement and to ensure their compliance with these restrictions. 
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G. NO GUARANTEE.  THE SOFTWARE IS  NEITHER GUARANTEED NOR WARRANTED
TO  BE  ERROR-FREE  NOR  SHALL  ANY  LIABILITY  BE  ASSUMED  BY  ALTOVA  IN  THIS
RESPECT.  NOTWITHSTANDING  ANY  SUPPORT  FOR  ANY  TECHNICAL  STANDARD,  THE
SOFTWARE  IS  NOT  INTENDED  FOR  USE  IN  OR  IN  CONNECTION  WITH,  WITHOUT
LIMITATION,  THE  OPERATION  OF  NUCLEAR  FACILITIES,  AIRCRAFT  NAVIGATION,
COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL EQUIPMENT, MEDICAL DEVICES OR
LIFE  SUPPORT  SYSTEMS,  MEDICAL  OR  HEALTH  CARE  APPLICATIONS,  OR  OTHER
APPLICATIONS  WHERE  THE  FAILURE  OF  THE  SOFTWARE  OR  ERRORS  IN  DATA
PROCESSING  COULD LEAD TO  DEATH,  PERSONAL  INJURY  OR  SEVERE  PHYSICAL  OR
ENVIRONMENTAL DAMAGE. YOU AGREE THAT YOU ARE SOLELY RESPONSIBLE FOR THE
ACCURACY  AND  ADEQUACY  OF  THE  SOFTWARE  AND  ANY  DATA  GENERATED  OR
PROCESSED BY THE SOFTWARE  FOR  YOUR  INTENDED  USE  AND  YOU  WILL  DEFEND,
INDEMNIFY AND HOLD ALTOVA, ITS OFFICERS AND EMPLOYEES HARMLESS FROM ANY
THIRD PARTY CLAIMS,  DEMANDS,  OR SUITS  THAT  ARE BASED UPON THE ACCURACY
AND ADEQUACY OF THE SOFTWARE IN YOUR USE OR ANY DATA GENERATED BY THE
SOFTWARE IN YOUR USE.

2.  INTELLECTUAL PROPERTY RIGHTS

You acknowledge that the Software and any copies that you are authorized by Altova to make are
the intellectual property of and are owned by Altova and its  suppliers.  The structure,  organization
and code of the Software are the valuable trade secrets  and confidential information of Altova and
its suppliers. The Software is protected by copyright, including without  limitation by  United States
Copyright  Law,  international  treaty  provisions  and  applicable  laws  in  the  country  in  which  it  is
being used.  You acknowledge that  Altova retains  the ownership of  all  patents,  copyrights,  trade
secrets,  trademarks  and  other  intellectual  property  rights  pertaining  to  the  Software,  and  that
Altova’s  ownership rights  extend to any images,  photographs,  animations,  videos,  audio,  music,
text and “applets” incorporated into the Software and all  accompanying printed materials.  You will
take  no  actions  which  adversely  affect  Altova’s  intellectual  property  rights  in  the  Software.
Trademarks shall be used in accordance with accepted trademark practice, including identification
of trademark owners’ names. Trademarks may only be used to identify printed output produced by
the Software,  and such  use  of  any  trademark  does  not  give  you  any  right  of  ownership  in  that
trademark.  Altova®,  XMLSpy®,  Authentic®,  StyleVision®,  MapForce®,  UModel®,
DatabaseSpy®, DiffDog®, SchemaAgent®, SemanticWorks®, MissionKit®, Markup Your Mind®,
Nanonull™, RaptorXML, RaptorXML  Server,  RaptorXML  +XBRL  Server,  Powered  By  RaptorXML,
FlowForce  Server,  StyleVision  Server,  and  MapForce  Server  are  trademarks  of  Altova  GmbH.
(pending or registered in numerous countries).  Unicode and the Unicode Logo are trademarks  of
Unicode, Inc. Windows, Windows XP, Windows Vista,  Windows 7,  Windows 8,  and Windows 10
are  trademarks  of  Microsoft.  W3C,  CSS,  DOM,  MathML,  RDF,  XHTML,  XML  and  XSL  are
trademarks (registered in numerous countries) of the World Wide Web Consortium (W3C);  marks
of  the  W3C are  registered  and  held  by  its  host  institutions,  MIT,  INRIA  and  Keio.  Except  as
expressly stated above, this Agreement  does not  grant  you any intellectual property  rights  in the
Software.  Notifications  of  claimed  copyright  infringement  should  be  sent  to  Altova’s  copyright
agent as further provided on the Altova Web Site.

3.  LIMITED TRANSFER RIGHTS

Notwithstanding  the  foregoing,  you  may  transfer  all  your  rights  to  use  the  Software  to  another
person  or  legal  entity  provided  that:  (a)  you  also  transfer  this  Agreement,  the  Software  and  all
other software or hardware bundled or pre-installed with the Software, including all copies, updates
and prior versions, and all  copies  of font  software converted into other formats,  to such person or
entity;  (b)  you  retain  no  copies,  including  backups  and  copies  stored  on  a  computer;  (c)  the
receiving party secures a personalized key code from Altova;  and (d) the receiving party  accepts
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the terms and conditions of this  Agreement  and any other terms and conditions upon which you
legally purchased a license to the Software.  Notwithstanding the foregoing,  you may not  transfer
education, pre-release, or not-for-resale copies of the Software.

4.  PRE-RELEASE AND EVALUATION PRODUCT ADDITIONAL TERMS

If the product you have received with this license is pre-commercial release or beta Software (“Pre-
release Software”), then this Section applies. In addition, this section applies to all evaluation and/
or demonstration copies of Altova software (“Evaluation Software”) and continues in effect until  you
purchase a license.  To the extent  that  any provision in this  section  is  in  conflict  with  any  other
term  or  condition  in  this  Agreement,  this  section  shall  supersede  such  other  term(s)  and
condition(s)  with  respect  to  the  Pre-release  and/or  Evaluation  Software,  but  only  to  the  extent
necessary to resolve the conflict. You acknowledge that the Pre-release Software is  a pre-release
version,  does  not  represent  final  product  from  Altova,  and  may  contain  bugs,  errors  and  other
problems that could cause system or other failures  and data loss.  CONSEQUENTLY, THE PRE-
RELEASE  AND/OR  EVALUATION  SOFTWARE  IS  PROVIDED  TO  YOU  “AS-IS”  WITH  NO
WARRANTIES  FOR USE OR PERFORMANCE,  AND ALTOVA  DISCLAIMS  ANY  WARRANTY
OR  LIABILITY  OBLIGATIONS  TO  YOU  OF  ANY  KIND,  WHETHER  EXPRESS  OR  IMPLIED.
WHERE  LEGALLY  LIABILITY  CANNOT  BE  EXCLUDED  FOR  PRE-RELEASE  AND/OR
EVALUATION SOFTWARE, BUT IT MAY BE LIMITED, ALTOVA’S LIABILITY AND THAT OF ITS
SUPPLIERS SHALL BE LIMITED TO THE SUM OF FIFTY DOLLARS (USD $50) IN TOTAL. If the
Evaluation  Software  has  a  time-out  feature,  then  the  software  will  cease  operation  after  the
conclusion of the designated evaluation period. Upon such expiration date, your license will  expire
unless otherwise extended.  Your license to use any output  created with the Evaluation Software
that  contains  generated program code (including Unrestricted Source Code) such as  Java,  C++,
C, VB.NET or XSLT and associated project files and build scripts  as  well as  generated XML, XML
Schemas,  documentation,  UML  diagrams,  and  database  structures  terminates  automatically
upon  the  expiration  of  the  designated  evaluation  period  but  the  license  to  use  such  output  is
revived upon your purchase of a license for the  Software  that  you  evaluated  and  used  to  create
such output. Access to any files created with the Evaluation Software is  entirely  at  your risk.  You
acknowledge that Altova has not promised or guaranteed to you that  Pre-release Software will  be
announced  or  made  available  to  anyone  in  the  future,  that  Altova  has  no  express  or  implied
obligation  to  you  to  announce  or  introduce  the  Pre-release  Software,  and  that  Altova  may  not
introduce  a  product  similar  to  or  compatible  with  the  Pre-release  Software.  Accordingly,  you
acknowledge  that  any  research  or  development  that  you  perform  regarding  the  Pre-release
Software or any product  associated  with  the  Pre-release  Software  is  done  entirely  at  your  own
risk. During the term of this Agreement, if requested by Altova, you will  provide feedback to Altova
regarding testing and use of the Pre-release Software,  including error or bug reports.  If  you  have
been provided the Pre-release Software pursuant to a separate written agreement,  your use of the
Software is governed by such agreement. You may not  sublicense,  lease,  loan,  rent,  distribute or
otherwise transfer the Pre-release Software. Upon receipt of a later unreleased version of the Pre-
release Software or release by  Altova of a publicly  released commercial version of  the  Software,
whether as a stand-alone product or as part of a larger product,  you agree to return or destroy  all
earlier  Pre-release  Software  received  from  Altova  and  to  abide  by  the  terms  of  the  license
agreement for any such later versions of the Pre-release Software. 

5.  LIMITED WARRANTY AND LIMITATION OF LIABILITY

A. Limited Warranty and Customer Remedies.   Altova warrants  to  the  person  or  entity
that first purchases a license for use of the Software pursuant to the terms of this  Agreement  that
(i) the Software will  perform substantially  in  accordance  with  any  accompanying  Documentation
for a period of ninety  (90) days from the date of receipt,  and (ii) any support  services provided by
Altova  shall  be  substantially  as  described  in  Section  6  of  this  Agreement.  Some  states  and
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jurisdictions do not  allow limitations  on  duration  of  an  implied  warranty,  so  the  above  limitation
may  not  apply  to  you.  To  the  extent  allowed  by  applicable  law,  implied  warranties  on  the
Software, if any, are limited to ninety (90) days. Altova’s  and its  suppliers’ entire liability  and your
exclusive remedy shall be, at Altova’s option, either (i) return of the price paid,  if any,  or (ii) repair
or  replacement  of  the  Software  that  does  not  meet  Altova’s  Limited  Warranty  and  which  is
returned  to  Altova  with  a  copy  of  your  receipt.  This  Limited  Warranty  is  void  if  failure  of  the
Software has resulted from accident, abuse, misapplication,  abnormal use,  Trojan horse,  virus,  or
any other malicious external code.  Any replacement  Software will  be warranted for the remainder
of the original warranty  period or thirty  (30) days,  whichever is  longer.  This  limited warranty  does
not apply to Evaluation and/or Pre-release Software. 

B. No Other Warranties and Disclaimer.   THE FOREGOING LIMITED WARRANTY AND
REMEDIES  STATE  THE  SOLE  AND  EXCLUSIVE  REMEDIES  FOR  ALTOVA  OR  ITS
SUPPLIER’S BREACH OF WARRANTY. ALTOVA AND ITS SUPPLIERS DO NOT AND CANNOT
WARRANT  THE  PERFORMANCE  OR  RESULTS  YOU  MAY  OBTAIN  BY  USING  THE
SOFTWARE.  EXCEPT  FOR  THE  FOREGOING  LIMITED  WARRANTY,  AND  FOR  ANY
WARRANTY, CONDITION, REPRESENTATION OR TERM TO THE EXTENT WHICH THE SAME
CANNOT OR MAY NOT BE EXCLUDED OR LIMITED BY LAW APPLICABLE TO YOU IN YOUR
JURISDICTION,  ALTOVA  AND  ITS  SUPPLIERS  MAKE  NO  WARRANTIES,  CONDITIONS,
REPRESENTATIONS  OR  TERMS,  EXPRESS  OR  IMPLIED,  WHETHER  BY  STATUTE,
COMMON LAW, CUSTOM, USAGE OR OTHERWISE AS TO ANY OTHER MATTERS. TO THE
MAXIMUM  EXTENT  PERMITTED  BY  APPLICABLE  LAW,  ALTOVA  AND  ITS  SUPPLIERS
DISCLAIM  ALL  OTHER  WARRANTIES  AND  CONDITIONS,  EITHER  EXPRESS  OR  IMPLIED,
INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY,  FITNESS
FOR A PARTICULAR PURPOSE, SATISFACTORY QUALITY, INFORMATIONAL  CONTENT OR
ACCURACY, QUIET ENJOYMENT, TITLE AND NON-INFRINGEMENT, WITH REGARD TO  THE
SOFTWARE,  AND THE  PROVISION OF  OR  FAILURE  TO  PROVIDE  SUPPORT  SERVICES.
THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS,
WHICH VARY FROM STATE/JURISDICTION TO STATE/JURISDICTION. 

C. Limitation  of  Liability.   TO  THE  MAXIMUM  EXTENT  PERMITTED  BY  APPLICABLE
LAW EVEN IF A REMEDY FAILS ITS ESSENTIAL PURPOSE, IN NO EVENT SHALL ALTOVA
OR ITS  SUPPLIERS  BE  LIABLE  FOR  ANY  SPECIAL,  INCIDENTAL,  DIRECT,  INDIRECT  OR
CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES
FOR  LOSS  OF  BUSINESS  PROFITS,  BUSINESS  INTERRUPTION,  LOSS  OF  BUSINESS
INFORMATION,  OR  ANY  OTHER  PECUNIARY  LOSS)  ARISING  OUT  OF  THE  USE  OF  OR
INABILITY  TO  USE  THE  SOFTWARE  OR  THE  PROVISION  OF  OR  FAILURE  TO  PROVIDE
SUPPORT SERVICES,  EVEN  IF  ALTOVA  HAS  BEEN  ADVISED  OF  THE  POSSIBILITY  OF
SUCH DAMAGES. IN ANY CASE, ALTOVA’S ENTIRE LIABILITY UNDER ANY PROVISION OF
THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR THE
SOFTWARE PRODUCT.  Because  some  states  and  jurisdictions  do  not  allow the  exclusion  or
limitation of liability,  the above limitation may not  apply  to you.  In such  states  and  jurisdictions,
Altova’s  liability  shall  be  limited  to  the  greatest  extent  permitted  by  law and  the  limitations  or
exclusions  of  warranties  and  liability  contained  herein  do  not  prejudice  applicable  statutory
consumer  rights  of  person  acquiring  goods  otherwise  than  in  the  course  of  business.  The
disclaimer and limited liability above are fundamental to this Agreement between Altova and you.

D. Infringement Claims.  Altova will  indemnify  and  hold  you  harmless  and  will  defend  or
settle any claim,  suit  or  proceeding  brought  against  you  by  a  third  party  that  is  based  upon  a
claim that the content contained in the Software infringes a copyright  or violates  an intellectual or
proprietary  right  protected  by  United  States  or  European  Union  law  (“Claim”),  but  only  to  the
extent  the Claim arises directly  out  of the use of the Software and subject  to the  limitations  set
forth  in  Section  5  of  this  Agreement  except  as  otherwise  expressly  provided.  You  must  notify
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Altova in writing of any Claim within  ten  (10)  business  days  after  you  first  receive  notice  of  the
Claim, and you shall provide to Altova at no cost such assistance and cooperation as  Altova may
reasonably  request  from time  to  time  in  connection  with  the  defense  of  the  Claim.  Altova  shall
have sole control over any Claim  (including,  without  limitation,  the  selection  of  counsel  and  the
right  to  settle  on  your  behalf  on  any  terms  Altova  deems  desirable  in  the  sole  exercise  of  its
discretion). You may, at your sole cost, retain separate counsel and participate in the defense or
settlement  negotiations.  Altova  shall  pay  actual  damages,  costs,  and  attorney  fees  awarded
against you (or payable by you pursuant to a settlement agreement) in connection with a Claim to
the  extent  such  direct  damages  and  costs  are  not  reimbursed  to  you  by  insurance  or  a  third
party, to an aggregate maximum equal to the purchase price of the Software. If the Software or its
use becomes the subject  of a Claim or its  use  is  enjoined,  or  if  in  the  opinion  of  Altova’s  legal
counsel the Software is  likely  to become the subject  of a Claim, Altova  shall  attempt  to  resolve
the Claim by using commercially  reasonable efforts  to modify  the Software or obtain a license to
continue using the Software. If in the opinion of Altova’s  legal counsel the Claim, the injunction or
potential Claim cannot be resolved through reasonable modification or licensing, Altova,  at  its  own
election, may terminate this Agreement without penalty, and will refund to you on a pro rata basis
any fees paid in advance by  you to Altova.  THE FOREGOING CONSTITUTES ALTOVA’S SOLE
AND EXCLUSIVE LIABILITY FOR INTELLECTUAL PROPERTY INFRINGEMENT. This  indemnity
does not  apply  to situations where the alleged infringement,  whether  patent  or  otherwise,  is  the
result of a combination of the Altova software and additional elements supplied by you.

6.  SUPPORT AND MAINTENANCE

Altova  offers  “Support  &  Maintenance  Package(s)”  (“SMP”)  for  the  Software  that  you  have
licensed,  which is  included with the  annual  license.  The  Support  Period  shall  coincide  with  the
license term. 

For an annual software license, you are eligible to receive the version of the Software edition that
you have  licensed  and  all  maintenance  releases  and  updates  for  that  edition  that  are  released
during your Support Period. Maintenance releases, updates and upgrades may or may not include
additional features. 

Altova will provide Priority Technical Support to you for the duration of the Support  Period.  Priority
Technical  Support  is  provided  via  a  Web-based  support  form  only  and  Altova  will  make
commercially  reasonable efforts  to respond via e-mail to all  requests  within forty-eight  (48) hours
during  Altova’s  business  hours  (MO-FR,  8am  UTC  –  10pm  UTC,  Austrian  and  US  holidays
excluded)  and  to  make  reasonable  efforts  to  provide  work-arounds  to  errors  reported  in  the
Software. 

During the Support  Period you may also report  any Software problem or error to Altova.  If Altova
determines  that  a  reported  reproducible  material  error  in  the  Software  exists  and  significantly
impairs  the  usability  and  utility  of  the  Software,  Altova  agrees  to  use  reasonable  commercial
efforts to correct or provide a usable work-around solution in an upcoming maintenance release or
update, which is made available at certain times at Altova’s sole discretion.

If Altova, in its discretion, requests written verification of an error or malfunction discovered by  you
or requests supporting example files that exhibit the Software problem, you shall promptly  provide
such verification or files, by email, telecopy, or overnight mail, setting forth in reasonable detail  the
respects  in which the Software fails  to perform. You shall use reasonable efforts  to cooperate  in
diagnosis  or  study  of  errors.  Altova  may  include  error  corrections  in  maintenance  releases,
updates,  or  new major  releases  of  the  Software.  Altova  is  not  obligated  to  fix  errors  that  are
immaterial.  Immaterial  errors  are  those  that  do  not  significantly  impact  use  of  the  Software  as
determined  by  Altova  in  its  sole  discretion.  Technical  support  only  covers  issues  or  questions
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resulting directly  out  of the operation of the Software and Altova will  not  provide you with generic
consultation, assistance, or advice under any circumstances.

Updating  Software  may  require  the  updating  of  software  not  covered  by  this  Agreement  before
installation. Updates of the operating system and application software not  specifically  covered by
this  Agreement  are your responsibility  and will  not  be provided  by  Altova  under  this  Agreement.
Altova’s obligations under this Section 6 are contingent upon your proper use of the Software and
your  compliance  with  the  terms  and  conditions  of  this  Agreement  at  all  times.  Altova  shall  be
under no obligation to provide the above technical support  if,  in Altova’s  opinion,  the Software has
failed  due  to  the  following  conditions:  (i)  damage  caused  by  the  relocation  of  the  Software  to
another location or CPU; (ii) alterations, modifications or attempts  to change the Software without
Altova’s  written  approval;  (iii)  causes  external  to  the  Software,  such  as  natural  disasters,  the
failure or fluctuation of electrical power, or computer equipment  failure;  (iv) your failure to maintain
the  Software  at  Altova’s  specified  release  level;  or  (v)  use  of  the  Software  with  other  software
without  Altova’s  prior  written  approval.  It  will  be  your  sole  responsibility  to:  (i)  comply  with  all
Altova-specified operating and troubleshooting  procedures  and  then  notify  Altova  immediately  of
Software  malfunction  and  provide  Altova  with  complete  information  thereof;  (ii)  provide  for  the
security  of  your  confidential  information;  (iii)  establish  and  maintain  backup  systems  and
procedures necessary to reconstruct lost or altered files, data or programs.

7.  SOFTWARE ACTIVATION, UPDATES AND LICENSE METERING

A. Software  Activation.   The  Software  may  use  your  internal  network  and  Internet
connection for the purpose of transmitting license-related data at the  time  of installation,
registration,  use,  or  update  to  an  Altova-operated  license  server  and  validating  the
authenticity of the  license-related data  in  order  to  protect  Altova  against  unlicensed  or
illegal  use  of the  Software  and to improve  customer service.  Activation is based  on  the
exchange of license related data  between your computer and the  Altova  license  server.
You agree  that Altova  may use  these  measures and you agree  to follow  any  applicable
requirements.  You further agree  that use  of license  key  codes that  are  not  or  were  not
generated by Altova and lawfully obtained from Altova,  or an authorized reseller as part
of an effort to activate or use the Software violates Altova’s intellectual property rights as
well  as the  terms  of  this  Agreement.  You  agree  that  efforts  to  circumvent  or  disable
Altova’s copyright protection mechanisms violate  Altova’s intellectual  property  rights as
well  as the  terms  of  this  Agreement.  Altova  expressly  reserves  the  rights  to  seek  all
available  legal  and  equitable  remedies  to  prevent  such  actions  and  to  recover  lost
profits, damages and costs.

B. LiveUpdate.  Altova provides a new LiveUpdate notification service to you,  which is  free
of  charge.  Altova  may  use  your  internal  network  and  Internet  connection  for  the  purpose  of
transmitting license-related data to an Altova-operated LiveUpdate server to validate  your  license
at appropriate intervals and determine if there is any update available for you.

C. Use of Data.  The terms and conditions of the Privacy Policy  are set  out  in full  at  http://
www.altova.com/privacy  and  are  incorporated  by  reference  into  this  Agreement.  By  your
acceptance  of  the  terms  of  this  Agreement  and/or  use  of  the  Software,  you  authorize  the
collection,  use and disclosure of information collected by  Altova for  the  purposes  provided  for  in
this Agreement and/or the Privacy Policy. Altova has the right  in its  sole discretion to amend this
provision of the Agreement  and/or Privacy Policy  at  any time.  You are encouraged to  review the
terms of the Privacy Policy as posted on the Altova Web site from time to time.

D. Audit Rights.  You agree that  Altova may audit  your use of the Software for compliance
with the terms of this Agreement at any time, upon reasonable notice. In the event that  such audit

http://www.altova.com/privacy
http://www.altova.com/privacy
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reveals  any  use  of  the  Software  by  you  other  than  in  full  compliance  with  the  terms  of  this
Agreement,  you  shall  reimburse  Altova  for  all  reasonable  expenses  related  to  such  audit  in
addition to any other liabilities you may incur as a result of such non-compliance.

E. Notice to European Users.  Please note that  the information as  described in paragraph
7 above may be transferred outside of the European Economic  Area,  for purposes of processing,
analysis, and review, by Altova, Inc., a company located in Beverly, Massachusetts, U.S.A., or its
subsidiaries  or Altova’s  subsidiaries  or divisions,  or  authorized  partners,  located  worldwide.  You
are advised that the United States uses a sectoral model of privacy protection that relies  on a mix
of legislation, governmental regulation, and self-regulation. You are further advised that the Council
of the European Union has found that  this  model does not  provide "adequate"  privacy protections
as contemplated by  Article 25 of the European Union's  Data Directive.  (Directive 95/46/EC, 1995
O.J. (L 281) 31).  Article 26 of the European Union's  Data Directive allows for transfer of personal
data  from  the  European  Union  to  a  third  country  if  the  individual  has  unambiguously  given  his
consent to the transfer of personal information, regardless of the third country's  level of protection.
By agreeing to this  Agreement,  you consent  to the transfer of all  such information to  the  United
States  and  the  processing  of  that  information  as  described  in  this  Agreement  and  the  Privacy
Policy.

8.  TERM AND TERMINATION

This  Agreement  may be terminated (a) by  your giving Altova written notice of termination;  (b)  by
Altova,  at  its  option,  giving  you  written  notice  of  termination  if  you  commit  a  breach  of  this
Agreement and fail to cure such breach within ten (10) days after notice from Altova;  or (c) at  the
request of an authorized Altova reseller in the event that you fail  to make your license payment  or
other monies due and payable. In addition the Agreement governing your use of a previous version
of the  Software  that  you  have  upgraded  or  updated  is  terminated  upon  your  acceptance  of  the
terms  and  conditions  of  the  Agreement  accompanying  such  upgrade  or  update.  Upon  any
termination  of  the  Agreement,  you  must  cease  all  use  of  the  Software  that  this  Agreement
governs,  destroy  all  copies  then  in  your  possession  or  control  and  take  such  other  actions  as
Altova  may  reasonably  request  to  ensure  that  no  copies  of  the  Software  remain  in  your
possession or control. The terms and conditions set forth in Sections 1G, 2,  5B,  5C,  5D, 7A,  7B,
7C, 7D, 7E, and 9-13 survive termination as applicable.

9.  RESTRICTED RIGHTS NOTICE AND EXPORT RESTRICTIONS 

The  Software  was  developed  entirely  at  private  expense  and  is  commercial  computer  software
provided with RESTRICTED RIGHTS. Use, duplication or disclosure by  the U.S.  Government  or a
U.S.  Government  contractor  or  subcontractor  is  subject  to  the  restrictions  set  forth  in  this
Agreement and as provided in FAR 12.211 and 12.212 (48 C.F.R. §12.211 and 12.212) or DFARS
227.  7202  (48  C.F.R.  §227-7202)  as  applicable.  Consistent  with  the  above  as  applicable,
Commercial  Computer  Software  and  Commercial  Computer  Documentation  licensed  to  U.S.
government end users  only  as  commercial items and only  with those rights  as  are granted to all
other  end  users  under  the  terms  and  conditions  set  forth  in  this  Agreement.  Manufacturer  is
Altova  GmbH,  Rudolfsplatz,  13a/9,  A-1010  Vienna,  Austria/EU.  You  may  not  use  or  otherwise
export or re-export the Software or Documentation except as authorized by United States  law and
the laws of the jurisdiction in which the Software was obtained. In particular, but  without  limitation,
the Software  or  Documentation  may  not  be  exported  or  re-exported  (i)  into  (or  to  a  national  or
resident of) any U.S.  embargoed country  or (ii) to anyone on the U.S.  Treasury  Department's  list
of Specially Designated Nationals or the U.S.  Department  of Commerce's  Table of Denial Orders.
By using the Software, you represent and warrant that  you are not  located in,  under control of,  or
a national or resident of any such country or on any such list.
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10.  U.S. GOVERNMENT ENTITIES

Notwithstanding the foregoing,  if you are an agency,  instrumentality  or department  of  the  federal
government  of the United States,  then this  Agreement  shall be governed in  accordance  with  the
laws of the United States of America, and in the absence of applicable federal law, the laws of the
Commonwealth  of  Massachusetts  will  apply.  Further,  and  notwithstanding  anything  to  the
contrary  in this  Agreement  (including  but  not  limited  to  Section  5  (Indemnification)),  all  claims,
demands,  complaints  and  disputes  will  be  subject  to  the  Contract  Disputes  Act  (41  U.S.C.
§§7101 et seq.), the Tucker Act  (28 U.S.C.  §1346(a) and §1491),  or the Federal Tort  Claims Act
(28  U.S.C.  §§1346(b),  2401-2402,  2671-2672,  2674-2680),  FAR  1.601(a)  and  43.102  (Contract
Modifications);  FAR  12.302(b),  as  applicable,  or  other  applicable  governing  authority.  For  the
avoidance of doubt,  if you are an agency,  instrumentality,  or  department  of  the  federal,  state  or
local government  of  the  U.S.  or  a  U.S.  public  and  accredited  educational  institution,  then  your
indemnification obligations are only  applicable to the extent  they would not  cause  you  to  violate
any applicable law (e.g., the Anti-Deficiency Act), and you have any legally  required authorization
or authorizing statute.
11.  THIRD PARTY SOFTWARE

The Software may contain third party software which requires  notices  and/or additional terms and
conditions.  Such required third party  software notices  and/or additional terms and conditions are
located at  our Website at  http://www.altova.com/legal_3rdparty.html and are made a  part  of  and
incorporated  by  reference  into  this  Agreement.  By  accepting  this  Agreement,  you  are  also
accepting the additional terms and conditions, if any, set forth therein.

12. TRANSLATIONS

Where  Altova  has  provided  you  with  a  foreign  translation  of  the  English  language  version,  you
agree  that  the  translation  is  provided  for  your  convenience  only  and  that  the  English  language
version  will  control.  If  there  is  any  contradiction  between  the  English  language  version  and  a
translation, then the English language version shall take precedence.

13.  GENERAL PROVISIONS

If you are located in the European Union and are using the Software in the European  Union  and
not  in the United States,  then this  Agreement  will  be governed by  and  construed  in  accordance
with  the  laws  of  the  Republic  of  Austria  (excluding  its  conflict  of  laws  principles  and  the  U.N.
Convention  on  Contracts  for  the  International  Sale  of  Goods)  and  you  expressly  agree  that
exclusive jurisdiction for any claim or dispute with Altova or relating in any way to your use of the
Software resides in the Handelsgericht,  Wien (Commercial Court,  Vienna) and  you  further  agree
and  expressly  consent  to  the  exercise  of  personal  jurisdiction  in  the  Handelsgericht,  Wien
(Commercial Court, Vienna) in connection with any such dispute or claim. 

If you are located in the United States  or are using  the  Software  in  the  United  States  then  this
Agreement will be governed by and construed in accordance with the laws of the Commonwealth
of  Massachusetts,  USA  (excluding  its  conflict  of  laws  principles  and  the  U.N.  Convention  on
Contracts for the International Sale of Goods) and you expressly  agree that  exclusive jurisdiction
for any claim or dispute with Altova or relating in any way to your use of the Software resides in
the  federal  or  state  courts  of  the  Commonwealth  of  Massachusetts  and  you  further  agree  and
expressly  consent  to  the  exercise  of  personal  jurisdiction  in  the  federal  or  state  courts  of  the
Commonwealth of Massachusetts in connection with any such dispute or claim.

If  you  are  located  outside  of  the  European  Union  or  the  United  States  and  are  not  using  the

http://www.altova.com/legal_3rdparty.html
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Software  in  the  United  States,  then  this  Agreement  will  be  governed  by  and  construed  in
accordance with the laws of the Republic  of Austria (excluding its  conflict  of laws principles  and
the U.N.  Convention on Contracts  for the  International  Sale  of  Goods)  and  you  expressly  agree
that exclusive jurisdiction for any claim or dispute with Altova or relating in any way to your use of
the  Software  resides  in  the  Handelsgericht,  Wien  (Commercial  Court,  Vienna)  and  you  further
agree and expressly  consent  to the exercise of personal jurisdiction in the  Handelsgericht  Wien
(Commercial Court, Vienna) in connection with any such dispute or claim. This Agreement will  not
be governed by the conflict  of law rules  of  any  jurisdiction  or  the  United  Nations  Convention  on
Contracts for the International Sale of Goods, the application of which is expressly excluded. 

This  Agreement  contains  the entire agreement  and  understanding  of  the  parties  with  respect  to
the subject matter hereof,  and supersedes all  prior written and oral understandings of the parties
with  respect  to  the  subject  matter  hereof.  Any  notice  or  other  communication  given  under  this
Agreement shall be in writing and shall have been properly given by either of us to the other if sent
by  certified  or  registered  mail,  return  receipt  requested,  or  by  overnight  courier  to  the  address
shown on Altova’s Web site for Altova and the address shown in Altova’s  records for you,  or such
other address as  the parties  may designate by  notice given in the  manner  set  forth  above.  This
Agreement will bind and inure to the benefit  of the parties  and our respective heirs,  personal and
legal representatives,  affiliates,  successors  and permitted  assigns.  The  failure  of  either  of  us  at
any time to require performance of any provision hereof shall in no manner affect such party’s  right
at a later time to enforce the same or any other term of this  Agreement.  This  Agreement  may be
amended  only  by  a  document  in  writing  signed  by  both  of  us.  In  the  event  of  a  breach  or
threatened breach of this  Agreement  by  either party,  the other shall have all  applicable equitable
as well as legal remedies. Each party is duly authorized and empowered to enter into and perform
this  Agreement.  If,  for  any  reason,  any  provision  of  this  Agreement  is  held  invalid  or  otherwise
unenforceable, such invalidity or unenforceability shall not  affect  the remainder of this  Agreement,
and this Agreement shall continue in full force and effect  to the fullest  extent  allowed by law.  The
parties knowingly and expressly consent to the foregoing terms and conditions.

Last updated: 2016-10-01
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